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Data import overview 
Schools Online allows you to import data from another administrative system. The files you 
can import MUST BE IMPORTED IN THIS ORDER. 

Your import files must use a CSV (comma separated value) format. 

 Candidates (SSABSACandidateExport.csv) 
 Teachers (SSABSATeacherExport.csv) 
 Class Structure (SSABSAClassStructureExport.csv) 
 Enrolments (SSABSAEnrolmentExport.csv) 
 VET Results (SSABSAVETResultsExport.csv) 
 VET Qualifications (SSABSAVETQualificationsExport.csv) 

Important import information 
 You can only import one file at a time. 
 Do not attempt to have two imports running at the same time. 
 We strongly recommend that imports should be performed by just one staff member with 

administrative rights to Schools Online. 
 Always import students and teachers before classes and enrolments. 
 If your student import file includes a student with a name identical to a student already in 

the database, the import will fail because the system will assume you are trying to create 
a duplicate. Remove the student from the import file and try again. If the second student 
is not a duplicate, you will need to enter that student manually through the Create 
Student screen. 

 Make sure your classes exist before importing SACE enrolments. 
 Administrative systems like SAMS will save the file in the W:\Keys\Integris\Outbox 

directory on your hard disk. 

Import warnings 
If warnings are generated the valid records will be taken on and the invalid records will be 
rejected, these warnings will be reported via an error message log. 

Examples of warnings are: 

Students 

 A student already exists on the database matching on surname, gender, date of birth and 
first character of given name. 

 The student (identified using the SACE Board Registration number) belongs to another 
school. 

 Student Code already used at the school (unique for school). 
 A students given name and/or surname contains non-printable characters. 

Teachers 

 The teacher for the class does not exist. 

You may need to import your teachers before importing SACE classes. 

Enrolments 

 The student for a SACE enrolment does not exist on the database. 

You may need to import your students first. 

 The student (identified using the SACE Board Registration number) belongs to another 
school. 

 The status of the enrolment is set to 'C' (Completed). 
 

VET 
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 The student for a VET enrolment does not exist. 

You may need to import your students first. 

 The student (identified using the SACE Board Registration number) belongs to another 
school. 



Schools Online Importing and Exporting Guide 

Revision date: February 2, 2015 10:02 AM 5 

Data import example 
There are times when the data you want to import into Schools Online from another 
administrative system needs to be checked and perhaps modified before importing it. The 
steps outlined in this section describe how the details of new Year 10 students (for example) 
can be imported into Schools Online from DUX, MAZE, SAMS or another administrative 
system and examined in Excel. 

Exporting from your administrative system 
Data must be first exported from the other system. Each administrative system will have its 
own way of exporting data. Most often the export routine will create a text file with the 
individual fields separated by a tab or comma, and sometimes quote marks are used to 
surround each piece of data. 

Checking the file format 
When your export file has been created, you can open it in Wordpad or Notepad to check 
the data format. This can be done by locating the file in Windows Explorer and double-
clicking the name of the file. It may open directly in your default text editor, or you may be 
prompted to select a text editor from a list. 

You can make changes to individual items in the file through your text editor. Don't forget to 
save the changes. If the problems can't be fixed easily in your text editor, load Excel and 
open your export text file. Follow the prompts to tell Excel how to interpret the data. 

Using the Excel import wizard 
1. The first section of the file will be displayed in the window at the bottom of the Text 

Import Wizard - Step 1 of 3 screen. 

 

Data Exchange 1 Select Delimited or Fixed Width 

2. When you view the section of your import file displayed in the bottom window of the first 
Import Wizard screen you will see that each piece of information (field) is surrounded by 
quotes (" ") and separated from the fields on either side by a comma (,). This indicates 
that the fields are Delimited (i.e. separated by commas, spaces, semi-colons, tabs or 
some other character), not fixed length fields. 

3. Choose Delimited from the Original data type list and click Next to move to the Text 
Import Wizard - Step 2 of 3. 
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Data Exchange 2 Choose the type of delimiter 

4. We have already seen from Data Exchange 2 that the data in the import file is delimited 
with commas, so select Comma from the Delimiters list. When you select an appropriate 
delimiter, lines will appear in the Data preview window to indicate how the data will be 
divided into cells in the spreadsheet. 

5. Choose an appropriate text qualifier from the list. (In this example, quotes surround each 
item of data, so " is chosen from the list.) 

6. Click Next to display the Text Import Wizard - Step 3 of 3 screen. 

 

Data Exchange 3 Convert Date and Numeric fields to Text format 

All columns in the data file are formatted as General. Dates and numeric data with leading 
zeros MUST be formatted to Text. 

7. Highlight the first column containing a date or numeric data and click Text in the Column 
data format window at the top of the screen. Continue across the file until all date and 
numeric columns show Text instead of General at the top of the column. 

8. Click Finish to display your data in a Microsoft Excel spreadsheet. 
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Checking the file format in Excel 
You can now view your data in an Excel spreadsheet. 

 

Data Exchange 4 The import data is displayed in an Excel spreadsheet 

 It is important that the data in the spreadsheet is arranged in the same order as shown in 
the student import file format. A complete list of import and export file formats can be 
found in the Data Exchange section of Schools Online Help. 

 Compare the order of the columns with the order of the fields shown in the student import 
file format list. If your file differs, change the order of the columns to match. (In the “Data 
Exchange 4” example, Surname (column D) comes before Given Names (column E). 
These columns need to be reversed.) 

Making changes in the file format 
To reverse the order of the Surname and Given Names fields: 

1. Insert a new column before the Surname column. To do this highlight the Surname 
column by clicking at the top of the column and choose Insert then Column. This will 
create a new empty column (column E). 
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Data Exchange 5 Reversing two columns in the spreadsheet 

2. Cut the Given Names column (now column F) and paste the data into the new column 
(column E) in front of the Surname column (now column G). 

3. Delete the column that previously held the Given Names data (column F). Highlight the 
empty column and choose Delete from the Edit menu list. The columns are now 
reversed. 

Further along the file I can see that the State Phone Code (column I) is shown as 8 (Data 
Exchange 6). We know it should be 08 so this means that this column was not set to Text in 
the Excel Import Wizard. 

 

Data Exchange 6 Editing the format of a column 
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To set the cell format to ‘text’ for column I: 

1.  Highlight the column and choose Cells from the Format menu list. 
2. Select Text from the list and click OK to apply the changes. 

 

Data Exchange 7 Export file is being prepared 

The value 8 has now moved to the left of the column, demonstrating that it has been 
formatted to Text. 

The cells having ‘8’ as their value are missing the leading zero required for this text field. 
Change the first value from 8 to 08. Press Enter to save the change then copy the new value 
down the whole column. 

Further data file considerations 
Missing Data 

Create empty columns for missing data. If your file does not have some of the fields listed in 
the Students import file format, create columns to match. If these extra columns are indicated 
as Optional (false), they may be left blank. If they are indicated as Mandatory (true), they 
must contain data. Columns after Year Level may be omitted if your file does not include data 
beyond that field. 

Data Accuracy 

Check the accuracy of the data and make changes as necessary. Errors need to be corrected 
at this stage. 

Date of Birth 

Check the format of the Date of Birth column. If the format is not correct, students will be 
brought into Schools Online with a birth date of 1/1/1950. The column should be formatted to 
Text and the dates should show in the format dd/mm/yyyy (e.g. 02/05/1984). 

Saving the file in Excel 
To save the edited data file from Excel: 

1. Select Save As from the File menu to save the file. 
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Data Exchange 8 Choose Save As 

2. Enter a new file name for this file. 
3. Click the down arrow to the right of the Save as type field and select CSV (Comma 

delimited) (*.csv) from the list. 

 

Data Exchange 9 Select csv from the list of file types 

4. Decide where you want to save the file and choose that location at the top of the screen. 
5. Click on the Save button. A message will ask whether you want to save the file in csv 

format. 



Schools Online Importing and Exporting Guide 

Revision date: February 2, 2015 10:02 AM 11 

 

Data Exchange 10 Accept the csv format and save 

6. Click on the Yes button. 
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Import file formats  

Candidates import file format  
The following table (Data Exchange 11) lists the fields, sizes and characteristics of the 
Candidates import file format for the Northern Territory. 

# NAME MAX 

LENGTH 
DATA 

TYPE 
REQUIRED OR 

MANDATORY 

FIELD 

INFORMATION 

1 Registration 7 Char False SACE Board's student's 
registration 

2 Student Code 20 Char True Student identifier, assigned by 
the school, unique within the 
school. 

3 Contact School 3 Char True School number issued by the 
SACE Board. 

4 Title 4 Char False For example Mr, Miss, Ms. 
5 Given Names 45 Char True Mixed case 
6 Surname 45 Char True Mixed case 
7 Gender 1 Char True M or F 
8 Aboriginal Torres Strait 

Islander Descent 
1 Char False Valid values: Blank, N, T, A, or 

Y 
9 Date of Birth 10 Char True The student's date of birth. 

Selectable output formats are: 
ddmmyyyy, dd/mm/yyyy, 
mmddyyyy, mm/dd/yyyy, 
yyyymmdd or yyyy/mm/dd. 

10 Phone Country Code 3 Char False If used, this must be a valid 
ABS country code (e.g. 061 = 
Australia). 

11 Phone Area Code 4 Char False (e.g. 08 = South Australia) All 
three parts of the phone code 
must be used, or none. 

12 Phone Number 10 Char False 8-10 digits containing no 
spaces. 

13 Address 1 30 Char True Student address for 
documentation delivery 

14 Address 2 30 Char False Only to be used if required. 
15 Address 3 30 Char False Only to be used if required. 
16 Address 4 30 Char False Only to be used if required. 
17 Suburb 45 Char True Will be converted to upper 

case. 
18 State 3 Char True Use OS for overseas 

addresses. 
19 Post Code 4 Char True Use OSOS for overseas 

addresses. 
20 Home Group 8 Char False Assigned by student’s contact 

school. 
21 Year Level 2 Char False 8, 9, 10, 11, 12, 13, or valid 

EDSAS Census Year Level. 
22 571 Visa Student 1 Char False Valid values: Y, N, - (Not Set), 

or Blank 
23 571 Fees Paid 1 Char False Valid values: Y, N, - (Not Set), 

or Blank 
24 HEES Declaration 

(SATAC) 
1 Char False Valid values: Y, N, - (Not Set), 

or Blank 
25 Institutions Declaration 

(School) 
1 Char False Valid values: Y, N, - (Not Set), 

or Blank 
26 Media Declaration 1 Char False Valid values: Y, N, - (Not Set), 

or Blank 
27 EDHO Number 13 Char False  
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# NAME MAX 

LENGTH 
DATA 

TYPE 
REQUIRED OR 

MANDATORY 

FIELD 

INFORMATION 

28 Language Spoken at 
Home 

4 Char False Valid ABS code or Blank 

29 Country of Birth 4 Char False Valid ABS code or Blank 
30 Email Address 100 Char False Students email address (where 

available) 
Data Exchange 11 Candidates import file format 

Teachers import file format  
The following table (Data Exchange 12) lists the fields, sizes and characteristics of the 
Teachers import file format for the Northern Territory. 

# NAME MAX 

LENGTH 
DATA 

TYPE 
REQUIRED OR 

MANDATORY 

FIELD 

INFORMATION 

1 Teacher Code 8 Char True Assigned by school, unique 
within school. 

2 Family Name 30 Char True The teacher's surname. 
3 Initials 4 Char True First character of each of the 

teacher's given names. 
4 Title 4 Char True The teacher's title. 

Data Exchange 12 Teachers import file format 

Class Structure import file format  
The following table (Data Exchange 13) lists the fields, sizes and characteristics of the Class 
Structure import file format for the Northern Territory. 

# NAME MAX 

LENGTH 
DATA 

TYPE 
REQUIRED OR 

MANDATORY 

FIELD 

INFORMATION 

1 Year 4 Integer True ccyy (e.g. 2015) 
2 Semester 1 Integer True 1 or 2 
3 Stage 1 Integer True 1 or 2 
4 SACE Code 3 Char True SACE Board SACE Code (e.g., 

'BIG' Alphanumeric). 
5 Credits 2 Integer True 10 or 20 
6 Class Number 2 Integer True Class number assigned by the 

teaching school (01 to 98 
inclusive) 

7 Program Variant 1 Char False A - Z or Blank 
8 Results Due 1 Char True J = June or D =December 
9 Teacher Code 8 Char True Assigned by school, unique 

within school 
10 School SACE Class 

Code 
10 Char False Assigned by school, unique 

within school 
11 Accession Number 8 Char False NT999999, where 999999 

represents a current 6 digit NT 
accession number. 

Data Exchange 13 Class Structure Import file format 
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Enrolments import file format  
The following table (Data Exchange 14) lists the fields, sizes and characteristics of the 
Enrolments import file format for the Northern Territory. 

# NAME MAX 

LENGTH 
DATA TYPE REQUIRED OR 

MANDATORY 

FIELD 

INFORMATION 

1 Registration 7 Char True SACE Board Registration 
Number. 

2 Enrolment Number 2 Integer False Positive Integer or Blank. 
3 Year 4 Integer True Year of Enrolment 
4 Semester 1 Integer True 1 or 2 
5 Stage 1 Integer True 1 or 2 
6 SACE Code 3 Char True SACE Board SACE Code (e.g., 

'BIG' Alphanumeric). 
7 Credits 2 Integer True 10 or 20. 
8 Class Number 2 Integer True Class number assigned by the 

teaching school (01 to 98 
inclusive) 

9 Results Due 1 Char True J = June or D = December. 
10 Program Variant 1 Char False A - Z or Blank 
11 Assessment School 3 Char True School number issued by the 

SACE Board. 
12 Enrolment Status 1 Char True E = Enrolled, W = Withdrawn, 

D = Deleted, G = Granted, C = 
Completed. Note: Imported 
values of G or C will be ignored 
by Schools Online. 

13 Repeat Indicator 1 Char True Valid values: Y, N 
14 Levelled Result 1 Char False V = OA, S = SA, R = RA, N = 

RNM, Blank if not completed 
15 NT Stage 1 Score 2 Integer False Integer score out of 20 (Blank if 

not completed) 
16 Stage 1 Grade 1 Char False A, B, C, D, E, N, P. This field 

only applies to SACE Stage 1 
enrolments (P=Pending - which 
will be rolled over automatically 
to the next semester). Values 
for non-graded subjects e.g. 
(PLP-Modified) will interpret C 
= Completed and N = Not 
Completed 

17 Partial Credits 2 Integer False Northern Territory Ignores this 
field.  

18 ED ID 13 Char False Northern Territory Ignores this 
field. Applies to EDSAS and 
Dux. Null/blank for data from 
other school administration 
systems. 

Data Exchange 14 Enrolments Import file format 
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VET Results import file format  
The following table (Data Exchange 15) lists the fields, sizes and characteristics of the VET 
Results AVETMISS Compliance import file format for the Northern Territory. 

# NAME MAX 

LENGTH 
DATA TYPE REQUIRED OR 

MANDATORY 

FIELD 

INFORMATION 

1 School Entering 
Data 

3 Char True School Code issued by SACE 
Board 

2 Training 
Organisation Name 

100 Char True This is the actual RTO that 
delivered the training in this 
module/competency. Gets 
stored in the VET Class table. 

3 VET Start Date 10 Char True dd/mm/yyyy (e.g. 16/03/2015) 
Date VET module/competency 
begun. 

4 Enrolment Number 2 Integer True Positive integer or blank for 
new, -1 for standalone 

5 VET Module 
Number 

3 Integer True  

6 VET Module ID 15 Char True National or State Competency 
Code (e.g. CPCCSH3005A) 

7 Result 2 Positive 
Integer 

False Valid AVETMISS Result (e.g. 
P, O or F) 

8 Registration 
Number 

7 Char True Unique SACE Board Student 
Identifier 

9 Enrolment Year 4 Positive 
Integer 

False ccyy (e.g. 2015)  
Blank if Module is standalone 

10 Semester 1 Positive 
Integer 

False 1 or 2 
Blank if Module is standalone 

11 Stage 1 Positive 
Integer 

False 1 or 2 
Blank if Module is standalone 

12 SACE Code 3 Char False Valid SACE Board SACE 
Subject Code (e.g. BIG - Alpha-
Numeric) 
Blank if Module is standalone 

13 Credits 2 Positive 
Integer 

False e.g. 10 or 20 
Blank if Module is standalone 

14 Class Number 2 Positive 
Integer 

False Positive Integer or Blank 
Blank if Module is standalone 

15 Program Variant 1 Char False A - Z or Blank 
Blank if Module is standalone 

16 Class Code 10 Char False Blank if Module is standalone 
17 Results Due 1 Char False J (June) or D (December) 

Blank if Module is standalone 
18 RTO ID 10 Char True RTO Code 
19 Certificate ID 10 Char True Qualification Code 
20 School Based New 

Apprenticeship 
1 Char False Y or N 

21 Training 
Organisation 
Delivery Location 
Identifier 

10 Char True  

Data Exchange 15 VET Results AVETMISS Compliance import file format 
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VET Qualifications import file format  
The following table (Data Exchange 16) lists the fields, sizes and characteristics of the VET 
Qualifications import file format for the Northern Territory. 

# NAME MAX 

LENGTH 
DATA TYPE REQUIRED OR 

MANDATORY 

FIELD 

INFORMATION 

1 School Entering 
Data 

3 Integer True School Code issued by SACE 
Board 

2 Registration 
Number 

7 Char True Unique SACE Board Student 
Identifier 

3 Course Code 10 Char True AVETMISS Course Identifier 
4 Completed 1 Char True Y or N 
5 Year Started 4 Char True ccyy (e.g. 2015) 
6 Year Completed 4 Char False ccyy (e.g. 2015) 
7 Issued 1 Char True Y or N. If ‘Y’ in Schools Online, 

it won’t overwrite via an import. 
Data Exchange 16 VET Qualifications import file format 
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Exporting data 
Schools Online allows you to export your data and view each data file on screen or save the 
file to disk. You can then import the data into another administrative software system. The 
export files you can generate are: 

 Enrolments (Enrolments.csv) 
 Subjects (Subjects.csv) 
 Candidates (Candidates.csv) 
 VET Module Reference (VETModuleRef.csv) 
 VET Results (VETResults.csv) 
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Saving an exported file from Schools Online 
Schools Online allows you to export your data and view each data file on screen or save the 
file. You can then import the data into another administrative software system. 

This procedure may appear differently on your screen if you are using a browser (and 
version) other than Microsoft Internet Explorer 10 and Mozilla Firefox. 

Microsoft Internet Explorer 10 
1. When the data has been extracted, you will be prompted Internet Explorer at the bottom 

of the screen. 

 

Data Exchange 17 Internet Explorer File Download prompt 

2. Click the down arrow next to Save button 
3. From the menu that has now appeared, click on Save As. 
4. As you chosen to save the file, you will be prompted to select a location for the file.  

 

Data Exchange 18 Internet Explorer file download Save As prompt 

5. Once you have selected by navigating to the most appropriate location to save the file 
click Save. 

The file has now been saved in the location selected and ready to be imported into another 
administrative system. 

Mozilla Firefox 
1. When the data has been extracted, you will be prompted and should choose to Save File 

and then click on OK. 
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Data Exchange 19 Firefox file download prompt 

2. As you chosen to save the file, you may be prompted to select a location for the file. 

 

Data Exchange 20 Firefox file download Save to prompt 

3. Once you have selected by navigating to the most appropriate location to save the file 
click Save. 

The file has now been saved in the location selected and ready to be imported into another 
administrative system. 
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Opening a 'dat' file exported from Schools 
online 
Most computers have file association so when you double click on a '.docx' file it will open 
Microsoft Word and that document will load. Files known as 'dat' file normally have no 
association and you will need to follow the instructions below to see the contents. 

1. Double click on the 'dat' file and it will try to open the file with the associated program but 
by default ‘dat’ files have no associated program. 

 

Data Exchange 21 Windows can’t open this file 

2. Select the option to Select a program from a list of installed programs and then click 
on OK. A list of the programs installed on your computer will be displayed in the Open 
with window. 

 

Data Exchange 22 Open With 

3. Select a program from the list. It is suggested you use Notepad, WordPad or Microsoft 
Excel unless you have a reason for choosing another program. 
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Export file formats 

Enrolments export file format  
The following table (Data Exchange 23) lists the fields, sizes and characteristics of the 
Enrolments export file format for the Northern Territory. 

# NAME MAX 

LENGTH 
VALIDATION INFORMATION 

1 Registration 7 Char SACE Board Registration Number. 
2 Enrolment Number 2 Char  
3 Year 4 Integer ccyy (e.g. 2015) 
4 Semester 1 Integer 1 or 2 
5 Stage 1 Integer 1 or 2 
6 SACE Code 3 Char SACE Board Subject Code (e.g., 'BIG' 

Alphanumeric). 
7 Credits 2 Integer 10 or 20. 
8 Class Number 2 Integer Class number assigned by the teaching 

school (01 to 98 inclusive) 
9 Results Due 1 Char J = June or D = December 

10 Program Variant 1 Char Characters A to Z only or is otherwise blank. 
11 Teaching School 3 Char School Number issued by SACE Board 
12 Assessment 

School 
3 Char School Number issued by SACE Board 

13 Enrolment Date 10 Char Date format: dd/mm/yyyy 
14 Enrolment Status 1 Char E = Enrolled, W = Withdrawn, D = Deleted, G 

= Granted, C =Completed 
15 Levelled Result 1 Char V = OA, S = SA, R = RA, N = RNM 
16 Exam Centre 3 Char School Number issued by the SACE Board 
17 Achievement 

Score 
2 Integer An integer between 0 and 20. 

Numeric Result for Enrolment, including NT 
Stage 1 Score. 

18 Speed 4 Integer Is a numeric with floating precision where - 1 
equates to NULL 
Numeric Result for Typing Speed (eg:40.5). 

19 Stage 1 Grade 1 Char A, B, C, D, E, N or P 
Only applies to SACE Stage 1 enrolments. 
(P=Pending and applies only to "completion 
requirement" subjects for which the enrolment 
will be rolled over to the next semester). 

Data Exchange 23 Enrolments export file format 

Subjects export file format  
The following table (Data Exchange 24) lists the fields, sizes and characteristics of the 
Subjects export file format for the Northern Territory. 

# NAME MAX 

LENGTH 
VALIDATION INFORMATION 

1 Stage 1 Integer 1 or 2 
2 SACE Code 3 Char SACE Board Subject Code (e.g., 'BIG' 

Alphanumeric). 
3 Credits 2 Integer 10 or 20. 
4 Expiry Date 10 Date Date format: dd/mm/yyyy 
5 Description 200 Text Subject Name 
6 Descriptor * Text *Extended Description (64k Max, No CR/LFs) 
7 Subject Type 1 Char P (PES), S (SAS), A (PAS) 

Data Exchange 24 Subjects export file format 
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Candidates export file format  
The following table (Data Exchange 25) lists the fields, sizes and characteristics of the 
Candidates export file format for the Northern Territory. 

# NAME MAX LENGTH VALIDATION INFORMATION 
1 Registration 7 Char SACE Board's student's Registration 

number. 
2 Student Code 20 Char Student identifier, assigned by the school, 

unique within the school. 
3 Surname 45 Char  
4 Givens 45 Char  
5 Title 4 Char  
6 Date of Birth 10 Date The student's date of birth. Selectable 

output formats are: ddmmyyyy, 
dd/mm/yyyy, mmddyyyy, mm/dd/yyyy, 
yyyymmdd or yyyy/mm/dd. 

7 Gender 1 Char M or F 
8 Contact School 3 Char School Number issued by the SACE Board 
9 Status 1 Char E = Enrolled, C = Completed, D = Deleted 

10 Date Completed 10 Date Date format: dd/mm/yyyy. 
Blank until SACE Board gives the 
candidate a Completed Status. 

11 Date Registered 10 Date Date format: dd/mm/yyyy. 
The date the candidate was registered with 
SACE Board. 

12 HEES Declaration 
(SATAC) 

1 Char Valid values: Y, N 

13 Institutions 
Declaration 
(Schools) 

1 Char Valid values: Y, N 

14 Media Declaration 1 Char Valid values: Y, N 
15 Certificate Printed 1 Char Valid values: Y, N 
16 Certificate Type 1 Char S (SA), N (NT), or Blank 
17 Deceased 1 Char Valid values: Y, N, or Blank 
18 EDHO Number 13 Char NT Department Student Code (Leading 

zeros preserved) 
Data Exchange 25 Candidates export file format 

VET Module Reference export file format  
The following table (Data Exchange 26) lists the fields, sizes and characteristics of the VET 
Module Reference export file format for the Northern Territory. 

# NAME MAX LENGTH VALIDATION INFORMATION 
1 Competency Based 1 Char Valid values: Y, N 
2 Curriculum Hours 3 Char Nominal Hours 
3 Vet Module ID 12 Char National or State Competency Code (e.g. 

CPCCSH3005A) 
4 Module Name 128 Char National or State Competency Name 
5 State Module ID 12 Char State Competency Code (e.g. 

CPCCSH3005A) 
6 TAFE SA Module 

ID / Unit of 
Competency Code 

10 Char TAFE SA Competency Code (e.g. MEMH) 

7 Expiry Date 10 Date Date format: dd/mm/yyyy 
Data Exchange 26 VET Module Reference export file format 
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VET Results export file format  
The following table (Data Exchange 27) lists the fields, sizes and characteristics of the VET 
Results export file format for the Northern Territory. 

# NAME MAX LENGTH VALIDATION INFORMATION 
1 School Entering 

Data 
3 Integer This will come from the vetClass information 

for this module or competency. 
2 Registration 

Number 
7 Char Unique SACE Student Identifier 

3 VET Start Date 10 Date Date VET module / competency begun. 
Note that the SAMS system uses this field 
as part of the primary key for their VET 
Results. Note also that the Year as stored in 
the VET Module table will have to be 
derived from this field for NT VET. 

4 Enrolment Number 2 Integer -1 if standalone 
5 VET Module 

Number 
3 Char VET Module Sequence Number - Blank if 

new VET Module for student. 
6 VET Module ID 12 Char National or State Competency Code (e.g. 

CPCCSH3005A) 
7 Result 2 Chat Valid AVETMISS Result (e.g. P, O or F) 
8 Enrolment Year 4 Integer Blank if module is standalone 

ccyy (e.g. 2015) 
9 Semester 1 Integer Blank if module is standalone 

1 or 2 
10 Stage 1 Integer Blank if module is standalone 

1 or 2 
11 SACE Code 3 Char Valid SACE Subject Code (e.g. BIG - Alpha-

Numeric) 
Blank if module is standalone 

12 Units 2 Integer Blank if module is standalone 
e.g. 10 or 20. 

13 Class Number 2 Char Blank if module is standalone 
14 Program Variant 1 Char Blank if module is standalone 

A - Z 
15 Results Due 1 Char Blank if module is standalone 

J (June) or D (December) 
16 VET Class Code 8 Char The VET Class identifier - Note: Different to 

SACE Class. 
Data Exchange 27 VET Results export file format 

 


